Working with Word
and other text files
A Guide for Freelance Indexers
▪

Introduction
This document is the first to be produced by the Future Group of the Society of Indexers. The
Future Group was set up in 2001 with the remit to consider the effect of technological
advances on indexing techniques. The Group considers that making efficient use of existing
tools, such as Windows and Microsoft Word, is a prerequisite for indexers in the twenty-first
century.
The present document is not intended to take the place of the many large textbooks on
Word and Windows that are already on the market. It covers only a selection of topics that are
likely to be helpful to indexers with limited experience in the use of word-processing
software.
The notes below are in alphabetical order, with hot links (in colour) that link to other
relevant entries. The left pane of the Acrobat PDF file contains a table of contents that also
provides links to the relevant pages.

▪

Attachments
All kinds of files can be sent as email attachments – Word documents, plain text files,
spreadsheets, graphics, etc. Usually the file extension will tell you what kind of file it is. If
your computer is set up to open these files automatically, you will see the appropriate icon
beside the filename. If you are a Windows user and your computer is not set to show file
extensions, rectify this – see File extensions, below. If there is just a Windows icon, your
computer does not know what program to use to open the file. See File Associations in the
Windows Help system to change these settings.
Some common file types you are likely to encounter as attachments are:
filename.txt a plain text file
may show the Wordpad or Notepad icon
filename.doc

probably a Word file

will show the Microsoft Word icon

filename.rtf

a Rich Text Format file

will also show the Word icon

filename.pdf

an Adobe Acrobat file

will show the Acrobat icon

PDF files (see below) are graphics files, not text files, and cannot be opened in Microsoft
Word.
Note that a file name consists of two parts: the name you give to the file, and the
extension. Although there is nothing to stop you altering the extension as well as the
filename, doing so prevents Windows recognizing what type of file it is, so that the file cannot
be opened by clicking on it. Attachments sent to outsiders should therefore always retain the
file extension as above.

Working with Word and other text files

2

Word files, RTF files, text files and files from most other wordprocessing programs can
be opened in Word (but see Converting files, below).
When you receive an attachment:
•
Check it for viruses unless your email software is set up to do this automatically. If
you are not sure how to do this, look at the help files in your virus protection software. (You
do have virus protection software, don’t you, and update it regularly?)
• Save it to a suitable folder, making sure it has a suitable and informative filename.
• Keep the original attachment, unamended, for archive purposes, either in your email
software or in a separate folder.

▪

Backups
Word will back up your work at short intervals in case of a power failure or system crash.
Check Tools, Options, Save to see how and specify how often. But note the following caveat
from Word Help:
AutoRecover is not a replacement for regularly saving your documents. If you choose not
to save the recovery file after Word opens it, the file is deleted and your unsaved changes
are lost. If you save the recovery file, it replaces the original document (unless you
specify a new file name).

If you want to save intermediate changes while continuing to work on the document, press
Ctrl-S at any time. Word will prompt you for a file name if you have not previously saved the
file.
You can choose to have Word automatically make a backup copy each time you open a
file, or you may prefer to keep your own incremental backups – a new version at the end of
each day, for example. If so, use Save As rather than Save to rename the files, and be sure to
follow a logical system of naming and storing them (for example, allocate a version number
to the first part of the filename). Think carefully before proliferating too many versions of a
file; it soon eats up disk space, and there is a serious risk of working on the wrong one.
To back up your work you only need to copy your data files (i.e. the files in My
Documents) on to whatever medium you are using for backup purposes – CD, Zip disk, a
tape-based backup facility, or floppy disks. It is sensible to do this regularly: how often
depends on how anxious you are and how much work you can bear to lose. To back up your
work, you only need to copy your data files. You don’t need to copy all the program files,
etc., as in the event of a disaster you will have to re-install the software anyway. However,
your personalized setting for Word are stored in a template file called normal.dot, so you
may want to keep a copy of this safe somewhere. Find it using the procedure described below
and copy it on to a floppy disk.
See also Folders and file management, below.

▪

Closing documents
The keyboard shortcut for closing a document and saving the changes you have made is
Ctrl-W, Enter.
To close all open documents without quitting Word, hold down Shift and click Close All
on the File menu (Shift-Alt-F). To see the Close All command, you must press the Shift key
before accessing the menu. (There are slight differences in file handling between Word 2000
and other versions, but this seems to work for all of them.)
Alt-F4 closes Word. You will be asked whether you want to save the changes you have
made to any open files before the program closes. Press the Escape key if you decide you
want to change your mind.
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Converting files
Recent versions of Word will open most types of text file you are likely to encounter.
Generally, a software package will not open files created with software newer than itself, e.g.
Word 6 will not open WordPerfect 8 files (although it may be possible to download a suitable
import filter from the Microsoft website).
Usually the formatting (bold, italic, sub/superscripts), embedding, etc. will be preserved.
The simpler the file, the more likely it is to be successfully converted. Complexities such as
footnotes or endnotes, graphics, maths, and special characters (e.g. Greek) increase the
chances of incorrect or incomplete conversion. Tools, Options, Compatibility gives a detailed
list of options which can be tweaked if necessary.
A file created in Word can be saved in many other formats: select Save As to see the
formats available on your system. If you are sending a file to someone who has an older
version of Word, or is working on a different platform (Mac/PC), it may be helpful to save the
file in a suitable version of Word, or as an RTF file.

▪

Copy, cut and paste
There are conventional keyboard shortcuts for these, which work in most Windows
programs (Ctrl-C and Ctrl-V are supported in recent versions of Macrex, but Ctrl-X is not):
Ctrl-C copy selected text
Ctrl-X

cut selected text

Ctrl-V paste selected text
These keys are all conveniently located close to one another on the keyboard, but if you prefer
there is an option in Word (not other programs) to use the Insert key to paste (via Tools,
Options, Edit).
Text that is copied or cut is stored in the clipboard. The Windows clipboard is quite
robust but can only hold one item at a time. What you put there will stay there until you
replace it with something else, even though you have closed applications and navigated
through various screens in the meantime. Word has a more complex clipboard facility that
will hold up to 12 items (in Word 2000) but this only works in Word and other Office
applications, not other programs. See Word Help for further details.

▪

Dropdown menus
The default in newer versions of Word is for dropdown menus not to show all options, but
only a selection of common or recently used ones. If there is a double v symbol at the bottom
of a toolbar it means there are more options, which are revealed by clicking on the symbol.
If you find this irritating and would prefer to see all the menu commands, go to View,
Toolbars, Customize, Options and clear the “Menus show recently used commands first”
check box. If you frequently use a particular command from a dropdown menu it may be
helpful to let Word bring it to the top of the dropdown (but quicker to learn a keyboard
shortcut – see below).

▪

Enter (return) key
This is the large key at the right of the main part of the keyboard, often with a “hooked arrow”
symbol.
• In a Word document, it inserts a hard return (end of paragraph).
• In all Windows dialog boxes (not just Word), pressing Enter is equivalent to clicking OK
with the mouse (and it’s quicker).
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Escape key
Using the Esc key (top left of the keyboard) is a quicker way to close dialog boxes, etc., than
clicking with the mouse.

▪

Fields, generated text, and hidden text
Word uses different modes (for lack of a better word) for special types of text:
• Embedded text, such as an index entry made with the indexing feature of Word, is hidden
text. This category also includes non-printing (formatting) characters such as spaces,
tabs, hard returns, and several others. All hidden text and formatting characters can be
revealed by toggling the Show All icon (¶) on the Word toolbar or the keyboard shortcut
Ctrl-Shift-8 (pressing Ctrl-Shift-8 again will remove the hidden text from view). Using
Tools, Options, View, Formatting marks (or Non-printing characters in earlier versions of
Word) gives the choice of showing hidden text and some or all of the formatting
characters.
• When you generate an index from embedded index terms, or a table of contents from
formatted headings, it appears as a field. Pressing Shift-F9 toggles between showing you
the field codes and the field itself, e.g. a generated index or table of contents.
• Fields do not function like normal text. To make sure you know what text is present as
fields, it can be distinguished by grey shading. Go to Tools, Options, View and select Field
shading, Always. This shading shows up on the screen but not on a printout (although see
Highlighted text, below).
• If you want to convert fields to ordinary text, select the required area (or use Ctrl-A to
select the whole document) and – to use Word’s terminology – break the links (Ctrl-ShiftF9).

▪

File extensions
For Windows users, the file extension (.doc, .txt, etc.) is a useful guide to the file type. Make
sure that your PC is set to show file extensions:
• In My Computer or Explorer, go to Tools, Folder Options, View (in Windows 98 it’s
View, Folder Options).
• Scroll down until you see “Hide extensions for known file types”.
• If there is a tick in this box, remove it, and click OK (or press Enter) to accept the change.
This will ensure that you always see complete file names such as index.doc or index.txt,
not just index (which could be any type of file).

▪

Find and Replace
This is one of the most powerful functions of Word. You can find not only words or
individual characters, but also paragraph style, text attributes (e.g. italic), colours, fonts, type
sizes, highlighting, or language. Click on the More box provides further options, such as
matching case or finding whole words only. There is also a complex but useful wildcard
search facility. See the Word Help system for details and examples.

▪

Finding files
To find a file when you don’t know what folder it is in, on the Windows Desktop select Start
(in the bottom left toolbar), or press the Windows key on your keyboard. Then go to Find
Files or Folders (called Search in Windows XP). Key in the filename, or as much of it as you
can remember, and select Search. Use the Help in the dialog box to see wildcard options that
are helpful if you can only remember part of the filename.
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Do not use Findfast (in Windows 95 and 98, but apparently no longer an option in
Windows XP, thank goodness). This utility continually creates a huge concordance to the
contents of every file on the hard disk. It interferes with other programs and slows everything
down. Disable it (see Windows Help for instructions) and remove the icon from your desktop
if it is there.

▪

Folders and file management
Folders (known as directories in DOS and earlier versions of Windows) are the electronic
version of a filing cabinet. From Windows 95 onwards, there has been a special folder called
My Documents that is the default location for storing all files created by Word or other
applications. You can’t delete this folder, but you can rename it if you don’t like the rather
primary school feeling of My Documents. To rename a file or folder, highlight it in My
Computer or Windows Explorer and click the right mouse button. This will reveal a file
management menu – Rename is one of the options.
You can create as many subdirectories as you need inside My Documents, e.g. one for
each clients, or one for each index – whatever seems a logical and memorable way or
organizing your work. Just saving everything straight into My Documents is no more sensible
than throwing all your papers randomly into a drawer.
In recent versions of Windows (Win95 onwards) files and folders are no long restricted to
the old DOS limitation of an eight-character file name with a three-character extension, but
can be given more detailed names if necessary.
To create a new subfolder within My Documents, open the folder in My Computer or
Windows Explorer and click on File, New, Folder. You then have the opportunity to name the
new folder; if you omit to do this it will just be called New Folder.
You can also create a new folder from within Word (or any other application that uses a
similar dialog box for saving files). Select File, Save As and click on the yellow icon with the
fuzzy corner (not the one with the arrow, which moves up one level in the hierarchy). This
will create a new folder within the one you are currently in.
You can copy or move files into any folder using My Computer or Windows Explorer. If
you just drag and drop with the mouse, files will be moved from one folder to another. If you
hold down the right mouse button as you drag, you will be give the option of moving the file,
copying it to the new location, or creating a shortcut to it. Files are always copied between
floppies or CDs and the hard disk, not moved – i.e. the file on the removable disk is not
affected by copying it to your hard disk, and vice versa.
If you are in danger of running out of disk space, you can copy old files on to removable
media – floppies, Zip disks, writable CDs – and delete them from your hard disk.
If you are unfamiliar with the basic procedures and terminology of file management and
this section and Windows Help do not provide enough information, a simple book such as one
of the “for Dummies” series (don’t be put off by the name) will prove a useful resource.

▪

Formatting
The term formatting is used very generally to describe many feature of an electronic
document, including paragraph styles (such as headings or bullet points) and character styles
(such as bold, italic, sub/superscript). It is these features that may be lost or misinterpreted in
file conversion.
To get rid of all formatting in a document, leaving just unformatted text, use Save As and
change the file type to Text Only. You might have to do this to clean up a file if the existing
formatting is very complex and very different from what is required in the final version, but it
is a very drastic step as removing the formatting will leave just the words and punctuation,
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paragraph returns and tab characters. The change will only take effect after the file is closed
and re-opened. By default, Word will prompt you to save to a new file (document.txt rather
than document.doc, say) so that you do not overwrite the original.
Formatting characters (known as non-printing characters in earlier version of Word) are
really instructions embedded in the file. You can make them visible by toggling the Show All
icon (¶) on the Word toolbar. If you have tidied away this icon from your toolbars, you can
use the keyboard shortcut Ctrl-Shift-8. Using Tools, Options, View, Formatting marks (or
Non-printing characters in earlier versions of Word) gives the choice of showing some or all
of the formatting characters.

▪

Help
Word’s Office Assistant is there by default, but can be disabled (right click on the Assistant
and choose Options). The advantage of the Office Assistant is that you can type in “plain
language” queries. The disadvantage is that it will only provide you with a small selection of
Help files, and unless you are very lucky they may not be the ones you need – and you may
find it irritating.
When the Office Assistant is disabled, pressing F1 will bring up the complete Help
contents. Note that several levels of subheading cascade from the main headings. It is worth
browsing through Help, because it provides information about a lot of options and shortcuts to
make work easier, but they are often difficult to find when you want them and (as usual with
computer help systems) the terminology is not always intuitive for the new user.
The Help system also contains an “Answer wizard”, i.e. a text search, like the one
available via the Office Assistant. Note that useful information may be hidden under
apparently irrelevant headings.
The Help files contain coloured hotlinks. Clicking on these opens up further files with
more detailed information.
Help topics can be printed out by using the usual Windows keyboard shortcut (Ctrl-P), or
clicking on the printer icon. You can also select text in the Help file by using the cursor, then
use Ctrl-C and Ctrl-V to copy and paste it into another document.
You can view Help in a full screen window, or resize it to take up a small part of the
screen (see Sizing windows, below). The text will re-flow, but the contents list won’t.
There is a lot of useful information in the Windows Help system too. Most other Windows
programs also use the F1 key to provide context-sensitive help.

▪

Highlighting text
You can highlight text with a superimposed colour by selecting the icon that looks like a
crayon (on the Reviewing toolbar, which you can find from View, Toolbars). The colour of
the highlighting is indicated by the line under the crayon (white = none). Highlighting will
show up on printouts as well as on screen (in shades of grey if you are not printing in colour –
choose a light colour for legibility).
A simple Find and Replace procedure to mark fields with a highlight that will show up
on a printout:
Ensure highlighting is set to the colour you want (click on the little triangle beside the crayon
and choose a colour).
Ensure field codes are visible (via Tools, Options, View, or the {a} icon if it is on one of your
toolbars)
Ctrl-H will bring up the Find and Replace dialogue
In the Find box, type ^d
In the Replace box, type ^&
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With the cursor still in the Replace box, select More, Format, Highlight
Select Replace All
Hide field codes (via Tools, Options, View, or the {a} icon)
This procedure can be saved as a macro using the Word macro recorder (see below).
Although highlighting can be extremely helpful for your own use, do not rely on it when
sending files to someone using a different version of Word. It is not always robust.

▪

Icons
see Toolbars

▪

Keyboard shortcuts
The underlined letter in a Word menu command indicates how to access it from the keyboard:
Alt-F for the File menu, Alt-E for the Edit menu, Alt-V for the View menu, etc.
Using the keyboard is quicker than using the mouse, so it is worth learning the shortcuts
for procedures you use frequently (see Navigating around a Word document, below). There
are keyboard shortcuts for almost all operations in Word. They are listed in Word Help, and
you can print out a complete list for reference. (Go to Tools, Macro, Macros, select Word
Commands in the Macros in: box, scroll down to ListCommands and click Run – it is several
pages long.)
It’s also possible to change the shortcut key combinations, or assign your own macros to
key combinations, but these won’t appear on the printout.
If you find it difficult to press several keys at once, Windows has a Sticky Keys option that
allows you to press them consecutively. Information about this (and other useful things) can
be found in the Windows Help system, under Accessibility Options.

▪

Macros
Any series of key presses or mouse clicks or Find and Replace procedures can be recorded
as a macro. It is a good idea to do this for repetitive procedures you use regularly, as the use
of macros rather than manual editing is a good way of ensuring consistency. The subject of
macros is too complex to be explained in depth here, but it is described in detail in the Word
Help system.

▪

Moving from one file to another
You can have up to nine documents open at once in Word. You can have each document
occupying the whole screen, or a small window. See Sizing windows. There are keyboard
shortcuts for moving between the windows. Ctrl-F6 takes you though all the open documents
in sequence. Crtl-W shows a list of open documents, and allows you to select one to move to.
This is more convenient than Ctl-F6 if you have several open documents.
You can copy, cut and paste text between Word documents just as you would within a
single document.
You can also have more than one Windows application running at the same time, e.g.
Word and Macrex. Holding down the Alt key and pressing Tab will take you in turn through
all the open applications – release the tab key when you get to the one you want.
You can copy, cut and paste from one Windows application into another.
If you have a lot of application windows open and are not sure where you are, you can
always get to the desktop with a single mouse click, using the Show Desktop icon near the
Start button (the one that has a picture rather like a cloth cleaning a window).
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Navigating around a Word document
You can use the mouse and the scroll bars, but the keyboard shortcuts give more control
(NB: some Mac keyboards do not have Page Up/Down or Home/End keys):
PC
Mac
Beginning of document

Ctrl-Home

Cmnd-Shift-Home

End of document

Ctrl-End

Cmnd-End

Top of screen

Ctrl-Alt-Page Up

Option-Cmnd-Page Up

Bottom of screen

Ctrl-Alt-Page Down

Option-Cmnd-Page Down

Beginning of line

Home

Shift-Home

End of line

End

End

Next line (down)

↓

↓

Next line (up)

↑

↑

Beginning of current para

Ctrl-↑

Cmnd-↑

Beginning of last para

Ctrl-↑↑

Cmnd-↑↑

Beginning of next para

Ctrl-↓

Cmnd-↓

Beginning of last word

Ctrl-←

Cmnd-←

Beginning of next word

Ctrl-→

Cmnd-→

Go to

Ctrl-G or F5

Cmnd-G

• The Go Back key (Shift-F5) returns the insertion point to each of the three previous
locations where you edited text, then goes back to the original position.
• The commands can be combined with Shift to select text, e.g. Ctrl-Shift-Home selects
everything between the current cursor position and the start of the document.
• The F8 key extends the selection – e.g. Crtl-Shift-F8+→ extends selection to the right one
word at a time.
• Using the Alt key (on a PC) with the mouse enables you to select any rectangular area of
the screen – you could use this to select the first letter of each line to change its case, for
example.

▪

Opening files
You can click on a file with the extension .doc in any folder and Word will open it.
Alternatively, open Word first and use File, Open, which also enables Word to open files that
do not have a .doc extension.
Word always displays the files in My Documents first. To navigate to another folder, use
the icon that looks like a file card with an arrow to move up one layer in the hierarchy and
select another folder.
Word lists the files you last used at the bottom of the File toolbar. In Tools, Options,
General you can choose how many recent files you want to list. The default is four, the
maximum is nine.

▪

PDF files
PDF stands for Portable Document Format, which is a proprietary format developed by
Adobe . These are not text files and they cannot be opened in Microsoft Word, or imported
into a Word document. The free Acrobat reader (available from http://www.adobe.com/)
enables you to view PDF files on screen and print them out.
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You can copy the text of a PDF file into Word (by first clicking on the large T on the
Acrobat toolbar or using Ctrl-A if you want to select the whole document), and then using
copy (Ctrl-C) and paste (Ctrl-V), but formatting will be lost.
If you have version 5 of the complete Acrobat program, not just the free reader, you can
save the text as an RTF file.

▪

RTF files
RTF stands for Rich Text Format, and it is a Microsoft proprietary format. RTF can be a good
way of transferring files between people who are using different versions of Word. Some
typesetters prefer them to *.doc files. Word will open RTF files automatically. You can create
an RTF file by using Save As and changing the file type.

▪

Selecting text
Small areas of text can be selected using the mouse, but if you try to extend the selection
beyond the area of the screen the cursor runs away (a well-known bug in Word that Microsoft
shows no signs of addressing). There are two solutions:
• Temporarily reduce the text size to say, 50%. You can do this from the View menu (View,
Zoom or Alt-V, Z) or use the zoom box (the one with a percentage in it) on the Formatting
toolbar at the top of the screen.
• Use keyboard shortcuts (See Navigating around a Word document, above): e.g. select
a paragraph at a time with Ctrl-Shift-↓, or a line at a time with Shift-↓, and you can then
use the left or right arrow to get to the point on the line that you want.

▪

Sizing windows
Open documents, Help files, etc., can either fill the whole screen area or part of it, so you can
see more than one document at a time. How useful this is depends largely on the size of your
screen (or the acuity of your eyesight).
• To re-size a window, hover the cursor over an edge or corner until you see a doubleheaded arrow and then click once and use the mouse to drag it to the size you want.
• To see two (or more) Word documents at once, open the files you want (you can have up
to nine Word documents open at once), then use Window, Arrange All and adjust the size
of the windows as described above. You can have them side by side, or one above the
other.
• To see different parts of a document at once, use Window, Split. You can navigate around
in each window separately.
See also Moving from one file to another

▪

Toolbars
• View, Toolbars brings up a list of the available toolbars. The ones currently in use are
ticked – tick on the others to see them (you can only do this one at a time, which is
annoying).
• The toolbars can be moved around the screen – hover the mouse over the left end of a
toolbar and a “handle” will appear that you can drag.
• All Word’s toolbars can be customized, i.e. you can add your own selection of icons and
remove the ones you don’t want. The default settings (i.e. Word as first installed) include
icons for many rather useless features, which are just a waste of space.
• To customize any toolbar, right-click on it and select Customize (at the bottom of the
drop-down menu). The Commands tabs brings up lists of most Word commands, arranged

Working with Word and other text files

10

in categories (View, Format, etc.) with icons you can drag to any toolbar. Many of these
are far more useful than Word’s default selection, and it is worth spending some time
investigating the options available.
• If you have created macros of your own, you can add them to a toolbar too: in the
Commands tab, scroll down to Macros to see a list. You can design your own icons for
toolbar buttons, or use Word’s built-in ones or text such as the name of the macro.

▪

Undo
Errors (or other editing steps) can be “undone” (Ctrl-Z or Edit, Undo). Word will step back in
order of every change you have made – it can’t distinguish between the changes you want and
the ones you don’t want! So the sooner you notice an error the easier it is to correct it.

▪

View
Various options are available via the View menu.
• For a short document such as a single-page letter, you will probably work in Page (Print
Layout) view.
• For a long document it is more convenient to work in Normal view (but be aware that this
will not show any graphics in the file).
• If the document headings have been suitably styled, selecting Document Map will give
you a contents list in a panel on the left of the screen (the panel can be re-sized using the
mouse). Clicking on the headings enables you to navigate around – a quick way to
navigate around a long document.
• The zoom factor (View, Zoom) can be adjusted. Selecting Page Width (or Text Width in
Print Layout view) will show the text as large as possible without horizontal scrolling.

▪

Wildcards
Wildcards make it quicker and easier to search for files in Windows. You can type just part of
the file name, and replace the rest by asterisks. For example, if you search for *.pdf you will
see a list of all the Acrobat PDF files on your system. If you search for b*.doc, all the PDF
files beginning with b will be listed, and so on. If you search for *.*, all files on your system
will be listed (but it might take a long time!)
Find and Replace in Word has powerful wildcard facilities, described in the following
information summarized from the Word Help system.
• If you don’t see the Use wildcards check box when you first open the Find dialogue, click
More.
• To choose a wildcard character from a list, click Special, click a wildcard character, and
then type any additional text in the Find what box.
• Alternatively, you can type a wildcard character directly in the Find what box (see the list
below).
• If you want to replace the item, enter what you want to use as a replacement in the Replace
with box.
• You can use parentheses to group the wildcard characters and text and to indicate the order
of evaluation. For example, type <(pre)*(ed)> to find “presorted” and “prevented”.
• You can use the \n wildcard to search for an expression and then replace it with the
rearranged expression. For example, type (Newton) (Christie) in the Find what box and
\2 \1 in the Replace with box. Word will find “Newton Christie” and replace it with
“Christie Newton”.
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• To search for a character that is defined as a wildcard, type a backslash (\) before the
character. For example, type \? to find a question mark.
To find

Use this
wildcard

Any single character
Any string of characters
One of the specified characters
Any single character in this range

?
*
[]
[-]

Any single character except the
characters inside the brackets
Any single character except
characters in the range inside the
brackets
Exactly n occurrences of the
previous character or expression
At least n occurrences of the
previous character or expression
From n to m occurrences of the
previous character or expression
One or more occurrences of the
previous character or expression
The beginning of a word

[!]

The end of a word

>

[!x-z]

Examples
s?t finds “sat” and “set”
s*d finds “sad” and “started”
w[io]n finds “win” and “won”
[r-t]ight finds “right”,“sight”, and “tight”.
Ranges must be in ascending order, e.g. 0–9,
1–2, A–Z, m–z
m[!a]st finds “mist” and “most”, but not
“mast”
t[!a-m]ck finds “tock” and “tuck”, but not
“tack” or “tick”

{n}

fe{2}d finds “feed” but not “fed”

{n,}

fe{1,}d finds “fed” and “feed”

{n,m}

10{1,3} finds “10”, “100”, and “1000”

@

lo@t finds “lot” and “loot”

<

<(inter) finds “interesting” and “intercept”,
but not “splintered”
(in)> finds “in” and “within”, but not
“interesting”

